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Matisse Menus
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The File Menu

The File Menu contains the standard commands of normal file management, 
plus scanning and printing commands.

File: New Create new image, folder or palette
File: Open Open an existing image, folder or palette
File: Duplicate Duplicate an image, folder or palette
File: Close Close the current image, folder or palette
File: Restore Restore the current window to it's last saved state
File: Add To Folder Add the current window to a folder
File: Save Save the current image, folder or palette
File: SaveAs Save under a new name
File: Save All Save all Open Windows
File: Acquire Acquire an image from a Twain source (eg:scanner)
File: Select Source Select Which Twain Source
File: Open PhotoCD Open a Photo-CD file (Version 1.2)
File: Scan Scan using Microtek Scanner
File: Print Print an Image
File: Print Setup Set Paper Tray and Other options
File: Preferences      Grid Size, Icon Size etc..



 
File: New

File: New: Image
File: New: Folder
File: New: Palette



 
File: New: Image

This command creates a new Color or Gray Scale Image. A dialog box 
prompts for the size of the image (in pixels or inches) and the resolution 
(dots per inch).    If desired enter a resolution other than the screen resolution
in the resolution field.    The resolution will effect the size of the image when 
printed.



 
File: New: Folder

This command creates a new empty folder. 



File: New: Palette

This command creates a new 256 color palette.    This palette is displayed in 
small format (no names).    Use the Palette Names command on the Edit 
Menu to change this so that you can input names.



 
File: Open

File: Open: Image
File: Open: Palette
File: Open: Folder



 
File: Open: Image

Opens an existing image using the standard Microsoft file dialog box.



 
File: Open: Palette

Opens an existing palette.    Palettes have a .pal extension.



 
File: Open: Folder

Opens an existing folder.    Folders have a .fld extension.



File: Duplicate

Creates a duplicate of the active window.    Depending on the window type, it 
will create a new Image, Folder or Palette. 



File: Close (F3)

Closes the current window. If changes have been made to the window, the 
program will ask whether you want to save those changes.



File: Restore

Restores the current window to its last saved state. 



 
File: Add to Folder

Manually adds the active window to an open folder. If there is only one folder 
open, the program will add the window object to that folder. Otherwise the 
program prompts you to select a folder from a list of open folders.

Note: An easier way to add images to folders is to iconify the image and then
drag the image into the folder. If you hold down the <shift> key, the image 
will be copied into the folder. Otherwise it will be cut into the folder. 



File: Save (F2)

Saves the active image, palette or folder.



File: SaveAs

Saves the active image, palette or folder under a new name. 



File: Save All (F4)

Saves all open images, palettes and folders.



File: Acquire

This command allows you to acquire an image via a TWAIN source, for 
example a TWAIN scanner or digital camera.    To set which source is active 
use the File: Select Source command.

Note: TWAIN is a standard interface which is common accross a range of 
input devices.    We highly recommend that when purchassing an input 
device such as a scanner or digital camera, you make sure that it is "TWAIN" 
compliant.    This will ensure that it is compatible with Fauve Matisse and 
other programs



File: Open PhotoCD (Version 1.2) 

This command allows you to retrieve images in Photo-CD format from your 
CD ROM drive. When applied it will automatically access your CD Rom drive 
and display a folder of thumbnails corresponding to the images on disk.    
Photo-CD stores each image in a number of different resolutions. A menu at 
the top of the PhotoCD folder allows you to specify which resolution you want
to import the image in as.    To activate the import, simply double click on the
photo-CD thumbnail.

Note that the folder will be kept around as a separate window, allowing 
access to the images on disk at any time.    The Window may be minimized to
conserve screen space or closed.



File: Select Source

This command allows you to switch between TWAIN sources.    For instance 
you could have several scanners connected to the computer, and you could 
be selecting Scanner2 as your TWAIN input source.



File: Scan

This leads to a scan menu which controls the scanner.    The menu and the 
controls are different depending on which scanner you have installed, ie: a 
standard TWAIN scanner or a non-TWAIN Microtek scanner.    By default, the 
program installation assumes your scanner is TWAIN (most likely).    To install 
an older Non-Twain Microtek scanner use the "Custom Install" option of the 
Matisse Install program



File: Print (Ctrl+P)

Prints the active image on your Windows compatible printer



File: Print Setup

Sets the print quality and number of copies



File: Preferences

File: Preferences: Gamma Correction
File: Preferences: Grid Size
File: Preferences: Icon Size
File: Preferences: GrayScale Only
File: Preferences: Windows Clipboard
File: Preferences: Printer Quality Text
File: Preferences: JPEG Compression Ratio
File: Preferences: LZW Compression



File: Preferences: Gamma Correction

When you click on this preference choice, a dialog box will appear allowing 
you to enter screen gamma values for the red, green and blue channels.    
These values affect the overall appearance of colors on your screen.    To 
ensure that Matisse is displaying true colors, you must "calibrate" your 
monitor by setting these values.

1.    Open the file "gamma.mat"

2.    Adjust the red gamma control until the outer and interior shades of red in
the image match precisely.    You can do this by using the "Preview" button 
after each trial value.

3.    Do the same for the green and blue channels.

4.    Hit OK to confirm.



File: Preferences: Grid Size

Like a draw program, Matisse supports "Snap to Grid" of objects.    "Grid Size"
refers to the size (in pixels) of this invisible grid.



File: Preferences: Icon Size

Sets the default icon size that is used for displaying minimized images, 
folders and palettes. 



File: Preferences: Gray Scale

Sets the display of all windows, images, icons etc. to gray scale. Useful for 
viewing gray scale images on non-24 bit displays (higher quality images). 
Color images will be rendered in gray, but the colors will not be lost.



File: Preferences: Windows Clipboard

If checked, all cut and copy operations will result in a duplicate copy being 
sent to the Microsoft clipboard.



File: Preferences: Printer Quality Text
.
When checked, this preference setting will cause Matisse to print text at the 
resolution of the printer as opposed to the resolution of the image.    This 
feature allows you to annotate a screen resolution image with letter quality 
text.



File: Preferences: JPEG Compression Ratio

This setting specifies a compression ratio from 1 to 100 for saving JPEG 
images. Beware of ratios greater than 4 that can lead to visible loss of image
quality.



File: Preferences: LZW Compression

When checked, this preference item will cause Matisse to save TIFF files 
using the so-called "LZW" compression scheme.



The Edit Menu

The Edit Menu contains commands for selecting marquee areas as well as 
the standard "Cut" "Copy" and "Paste commands".

Edit: Undo Undo the last command
Edit: Cut Cut to the clipboard
Edit: Copy Copy to the clipboard
Edit: Paste Paste as Object or New Document
Edit: Marquee All Set Marquee to Entire Window
Edit: Marquee Invert Invert Marquee
Edit: Marquee None Eliminate Marquee
Edit: Clear Clear to white
Edit: Fill Fill to a color or pattern
Edit: Set Pattern Define a new Current Pattern
Edit: Set Texture Define a new Current Texture
Edit: Brushes Edit Brush Set
Edit: Palette Edit Current Palette
Edit: Folder Edit Folder Options



Edit: Undo (Alt+Bksp)

Undoes the last operation.



Edit: Cut (Shift+Del)

Cuts the current selected object to the private clipboard.    Normally it will 
also cut a copy to the Microsoft Windows clipboard for easy communication 
with other applications.    This feature can be turned off in the Preferences 
Menu.



Edit: Copy (Ctrl+Ins)

Copies the current selected object to the clipboard.    Normally it will also 
copy a copy to the Microsoft Windows clipboard for easy communication with
other applications. This feature can be turned off in the Preferences Menu.



Edit: Paste (Shift+Ins)

Pastes the content of the clipboard into the current window. If the Windows 
clipboard is non-empty it will use that clipboard, otherwise it will use the 
private clipboard.

Note (Version 1.2). Fauve Matisse can now "Paste as New Document".    This 
feature is convienent for interfacing with external applications.



Edit: MarqueeAll (Ctrl+A)

Creates a marquee including all of the current window.



Edit: Marquee Invert

Inverts the current Marquee.



Edit: Marquee None (Ctrl+D)

Discards the current marquee 



Edit: Clear (Ctrl+Del)

Sets all selected image objects to white. If no image objects are selected, 
sets the background image to white.

Note: if the image is a transparency, clear will effect the opacity layer as 
well, making the image 100% transparent.



Edit: Fill

Fills all currently selected objects. If no objects are selected, the fill will apply 
to the background image. In either case, the fill will be clipped to the 
marquee, if one is present.



Edit: Set Pattern

Defines the current pattern.    If the active window is an image window, it will 
use that image (clipped to the marquee) as the new pattern.    If the active 
window is a folder, it will use the first selected image in the folder as the new
pattern.



Edit: Set Texture

Re-defines the current texture.    If the active window is an image window, it 
will use that image (clipped to the marquee) as the new texture.    If the 
active window is a folder, it will use the first selected image in the folder as 
the new texture.



Edit: Brushes

Menu commands for editing the brush set.

Edit: Brushes: Open
Edit: Brushes: SaveAs
Edit: Brushes: Add Category
Edit: Brushes: Add Brush
Edit: Brushes: Delete Category
Edit: Brushes: Delete Brush
Edit: Brushes: Set Category Icon
Edit: Brushes: Get Category Icon
Edit: Brushes: Set Brush Icon
Edit: Brushes: Get Brush Icon



Edit: Brushes: Open

Opens an existing brush set (extension .brs).



Edit: Brushes: Save As

Saves the brush set under a new name.



Edit: Brushes: Add Category

Inserts a new default category into the brush box



Edit: Brushes: Add Brush

Inserts a new default brush into the brush box



Edit: Brushes: Delete Category

Deletes the current category from the brush box. 



Edit: Brushes: Delete Brush

Deletes the current brush from the brush box



Edit: Brushes: Set Category Icon

Uses the current image window to (re)-set the current category icon.    If the 
current image window is not 64x64 pixels, the icon is obtained by 
resampling.



Edit Brushes: Set Brush Icon

Uses the current image window to (re)-set the current brush icon.    If the 
current image window is not 64x64 pixels, the icon is obtained by 
resampling.



Edit: Brushes: Get Category Icon

Copies the current category icon into a new image window.



Edit: Brushes: Get Brush Icon

Copies the current brush icon into a new image window



Edit: Palette

Menu commands for editing the current palette.

Edit: Palette: Find
Edit: Palette: Find By Name
Edit: Palette: Interpolate
Edit: Palette: Rectangle Interpolate
Edit: Palette: Resize
Edit: Palette: SampleImage
Edit: Palette: Names



Edit: Palette: Find

Finds the closest matching color to the foreground color in the palette.



Edit: Palette: Find By Name

Brings up a dialog box where you can search for a palette color by name.



Edit: Palette: Interpolate

Interpolates between the top left selected color and the bottom right 
selected color to provide a range of intermediate palette colors.



Edit: Palette: Rectangle Interpolate

Interpolates between the four corners of the selected area in the palette to 
give a 
"Gouroud" shading of intermediate colors.    Useful for deriving blends of 
several colors.



Edit: Palette: Resize

Allows you to change the number of palette rows and columns (by default 
palettes are 16x16 and contain 256 colors).



Edit: Palette: Sample Image

Creates a new palette by computing out the top colors in the image using the
Heckbert quantization technique. 

Once you have the top colors of an image, you can use these colors to 
colorize another image with the Colorize command.    This can produce 
remarkable results!



Edit: Palette: Names

Allows you to view the palette in large format, so that the names are visible.  
This command acts as a toggle.



Edit: Folder

Edit: Folder: Resize
Edit: Folder: Get Cover
Edit: Folder: Set Cover



Edit: Folder: Resize

Resizes the icons in the current folder.



Edit: Folder: Get Cover

Copies the folder cover    into a new image window.    The folder cover is the 
image that is shown when the folder is iconified, or dragged into other 
folders.



Edit: Folder: Set Cover

Sets the cover of a folder using the current image window.    The folder cover 
is the image that is shown when the folder is iconified, or dragged into other 
folders.



The Image Menu

The Image menu contains all of the filters in Matisse as well as some image 
processing commands.

Image: Tune
Image: Blur
Image: Convolution
Image: Distort
Image: Edge Detect
Image: Mosaic
Image: Noise
Image: Texturize
Image: Separate
Image: Recombine
Image: Convert
Image: Crop
Image: Flip
Image: Rotate 90
Image: Resample
Image: AutoPaint



Image: Tune

Image: Tune: Brightness/Contrast
Image: Tune: CMYK
Image: Tune: Colorize
Image: Tune: Equalize
Image: Tune: Invert
Image: Tune: HLS
Image: Tune: Posterize
Image: Tune: RGB
Image: Tune: Tint
Image: Tune: Tone



Image: Tune: Brightness/Contrast

Similar to the Brightness/Contrast controls on a TV. Increasing brightness 
adds pure white to the image. Increasing contrast tightens the color range. 



Image: Tune: CMYK

Adds/Subtracts a fixed amount of Cyan, Magenta, Yellow or Black to each 
pixel in the image.



Image: Tune: Colorize

Colorizes an image using a 256-color palette.    If you don't have such a 
palette, you can use the Edit: Palette: Sample Image command to extract 
one from another image. 

Note: This command only works on color images. If you want to colorize a 
gray scale (8 bit image) first convert it to True Color, and then apply the 
command.

See Also: Edit: Palette: Sample Image



Image: Tune: Equalize

This command equalizes out the image to contain an even mix of light and 
dark areas. It is particularly useful for re-touching under or over-exposed 
photographs, particularly gray-scale ones.



Image: Tune: Invert

Inverts the image, producing a negative.



Image: Tune: HLS

Adds/subtracts hue, lightness, and or saturation. Pumping up the saturation 
on an image is often a good way of adding life to it. 



Image: Tune: Posterize

The term "posterize" means to compress the range of    color values. For 
example, on a gray scale image, setting the posterize level to five will result 
in each channel going from 256 shades to 5 shades. This results in images 
which are somewhat "blotchy".    



Image: Tune: RGB

Adds/Subtracts a fixed amount of Red, Green or Blue to each pixel in the 
image.



Image: Tune: Tint

Creates a 256-shade image which "leans" towards the foreground color. 
Gives a very clean, "tinted" look to an image or area which you cannot get by
other tuning adjustments.



Image: Tune: Tone

Overall tone adjustment facility. Allows you to increase the shadows, 
midtones or highlights of the image and see the effects on the image 
interactively. The controls in effect re-ramp each of the gamma curves for 
the three channels R, G and B.



Image: Blur

Filters for blurring an image.

Image: Blur: Blur
Image: Blur: Fragment
Image: Blur: Motion Blur
Image: Blur: Gaussian Blur
Image: Blur: Uniform Blur



Image: Blur: Blur

Applies a 3x3 convolution blur to the image. A blur amount parameter is 
used to increase/decrease the weight on the center pixel, mildly changing 
the degree of blur.

Use for: applying a mild blur to the image.



Image: Blur: Fragment

Superimposes a specified number of copies at random offsets. The variance 
of these offsets can be specified in pixels. 

Use for: creating the effect of a "jiggled" camera. 



Image: Blur: Motion Blur

Superimposes a specific number of copies at a given distance from each 
other and at a specified angle to create the impression of movement. Using 4
or more copies at a distance of 3 pixels yields good results.

Use for: creating the impression of movement.



Image: Blur: Gaussian Blur

Applies a smooth normalized or "gaussian" blur filter to the image. More 
"soft" than other blur filters, but slower. Blur amount is specified by a radius 
in pixels (1-5).

Use for: creating "soft lens" effects.



Image: Blur: Uniform Blur

Applies a uniform blur filter to the image. Essentially the same as the 
standard blur filter, but with a variable radius of up to 5 pixels (10x10 
convolution). Like the gaussian blur, can be slow, especially on large images.

Use for: creating "soft lens" effects.



Image: Convolution

The term "convolution" is an image-processing term for a class of filters 
which are defined by a matrix of numbers. For each pixel, the new RGB 
values are defined as a weighted sum of the adjacent pixels. The convolution
matrix allows you to enter these weights. The result is divided by a scale 
factor, and shifted by an offset.

Use for: creating your own filters.



Image: Distort

Filters for distorting an image.

Image: Distort: Cylinder
Image: Distort: Fish Eye
Image: Distort: Ripple
Image: Distort: Wave
Image: Distort: Whirlpool



Image: Distort: Cylinder

This filter maps the image to a cylinder, like a "special effects" mirror at an 
amusement park. You can specify an amount between -100 and +100. A 
positive amount will cause the image to "bulge" , a negative amount will 
cause it to be "squeezed". You can also specify whether the cylinder is 
vertical or horizontal.

Use for: creating cylinder-like bulges and squeezes.



Image: Distort: Fish Eye

Creates the impression the picture was taken through a fish-eye lens. The 
degree of "bulge" is controllable with an amount parameter. Specifying a 
negative amount will cause the image to be "pinched"

Use for: creating fish-eye or pinched effects.



Image: Distort: Ripple

Creates a "rippled" wave over the image, similar to looking through heavy 
plate glass on a rainy day. The ripple is controlled by a wavelength and an 
amplitude factor. The best way to see how these two parameters interact is 
by playing around with them!

Use for: creating a non-directional ripple over an image.



Image: Distort: Wave

Creates a horizontal or vertical wave on the image. The wavelength and 
the amplitude of the wave can be specified. Like the Ripple filter, this one 
takes some trial and error to get comfortable with.

Use for: creating waves in an image.



Image: Distort: Whirlpool

Passes the image through a whirlpool vortex, creating a "twirl" effect. A twist 
amount in degrees (between -360 and +360) controls the degree of twirl.

Use for: "twirling" all or part of the image. 



Image: Edge Detect

Filters that detect and act on the edges of the image.

Image: Edge Detect: Emboss
Image: Edge Detect: Find Edge
Image: Edge Detect: Sharpen
Image: Edge Detect: Threshold
Image: Edge Detect: Variable Edge



Image: Edge Detect: Emboss

Creates an "embossed look" using directional gradient information. The 
emboss depth controls how "protruded" the embossing looks. The contrast 
parameter is useful for increasing the sharpness of    the embossing. The 
emboss angle is entered in degrees. Finally, you can specify a background 
color for embossing: foreground, background or gray. 

Note: you can also emboss an object interactively with any paintbrush by 
setting the object compositing rule of that object to emboss. 



Image: Edge Detect: Find Edge

Standard filter which finds all edges of the image and displays them in white 
on a black background. By checking the invert box, you can specify black 
edges on a white background.

Use for: special effects.



Image: Edge Detect: Sharpen

Accentuates the edges of an image to increase the perceived "sharpness". A 
single parameter, amount, is used to regulate the degree of edge 
enhancement.

Use for: sharpening blurred images.



Image: Edge Detect: Threshold

This filter classifies all pixels into two categories: those whose R,G,B values 
are above a certain threshold and those who are below. The R,G,B 
threshold values are entered with three sliders and can be constrained to 
be equal by clicking on the constrain checkbox. You specify one color for the
"above" pixels and one for the "below" pixels.

Use for: creating "Andy Wharhol" like thresholded images.



Image: Edge Detect: Variable Edge

A highly versatile filter for the image professional. For each pixel an edge 
gradient is computed. Depending on whether the edge is greater or less than
a specific threshold, the pixel is colored in the "above" color or the "below" 
color. Color choices include
HiLite (which sharpens the pixel) , Unchanged (leaves the pixel as is) and 
Raw (the raw gradient number, as displayed by the standard Find Edge 
filter).

Use for: sophisticated edge detection and special effects.



Image: Mosaic

Included under this heading are filters which produce a clustered "mosaic" 
effect.

Image:           Mosaic: Maximum  
Image: Mosaic: Median
Image: Mosaic: Minimum
Image: Mosaic: Mosaic
Image: Mosaic: Shatter



Image: Mosaic: Maximum

This filter replaces each pixel with the lightest (maximum) pixel in a 
neighborhood around it. The neighborhood radius is given in pixels. Using 
values greater than 1 can slow this filter considerably.

Use for: clustering the image pixels into areas of maximum lightness.



Image: Mosaic: Median

This filter replaces each pixel with the median lightness pixel in a 
neighborhood around it. The neighborhood radius is given in pixels. Using 
values greater than 1 can slow this filter considerably.

The effect of the median filter is to blur the image without destroying edges. 
It is perfect for removing noise from an image, or blurring flat parts of an 
image while keeping straight lines relatively crisp. While not really a 
"mosaic" filter, we included it here to be next to the minimum and maximum 
filters.

Use for: controlled blurring and noise removal.



Image: Mosaic: Minimum

This filter replaces each pixel with the darkest (minimum) pixel in a 
neighborhood around it. The neighborhood radius is given in pixels. Using 
values greater than 1 can slow this filter considerably.

Use for: clustering the image pixels into areas of minimum lightness.



Image: Mosaic: Mosaic

Creates the "police suspect" look by grouping pixels in tiles and coloring each
tile with its average color. You can specify the width and height of the tiles, 
and constrain these to be equal by click the square checkbox.

Use for: "pixelating" an image into rectangular tiles.



Image: Mosaic: Shatter

Creates a "David Hockney" look by cutting the image up into tiles and 
moving the tiles randomly around. You specify the tile width and height, the
average movement in pixels, and optionally an amount of random tinting 
that is applied to each tile.

Use for: David Hockney effects.



Image: Noise

These filters add/subtract random noise to the picture.

Image: Noise: Add Noise
Image: Noise: Diffuse
Image: Noise: Remove Noise



Image: Noise: Add Noise

Adds a specific amount of white noise to the image. The amount is specified
between 1 and 255.

Use for: adding a grainy noise background to your image.



Image: Noise: Diffuse

Moves each pixel by a random amount, creating a very nice "grainy 
breakdown" of the image. 

Use for: creating soft, artistic grainy breakdowns.



Image: Noise: Remove Noise

Checks each pixel's color relative to the median color of the neighboring 
pixels. If the difference is greater than a threshold, the pixel color is replaced 
with the median color. The strength parameter controls the noise threshold.

Use for: cleaning up spotty images.



Image: Texturize

Texturizes the image using the current texture. The texture amount can be 
set to a number between 1 and 200. The angle of the light source can be 
entered in degrees.

Use for: adding paper texture to images.



Image: Separate

These commands break an image down by channel.

Image: Separate: RGB
Image: Separate: HLS
Image: Separate: CMYK

After separating out an image into the different channels, each channel is 
given its own window, and can be modified using any of the paint or image 
processing commands. The Image: Recombine command can then be used 
to re-create a composite of the different channels.

See also: Image: Recombine



Image: Separate: RGB

Separates an image out into its Red, Green and Blue channels.



Image: Separate: HLS

Separates an image out into Hue, Lightness and Saturation channels.



Image: Separate: CMYK

Separates an image out into the print standard Cyan, Magenta, Yellow and 
Black channels. To optimize the separation, you can modify any of the 
following parameters:

Threshold:    Starting threshold in % below which there is no black being 
generated.
Black generation: max % of black that will be generated.
Under color removal: % of black that will be removed from each C,M,Y 
triplet.



Image: Recombine

Recombines a set of    gray scale channels to form a color image. You must 
select whether to recombine split RGB, HLS or CMYK images.

See also: Image: Separate



Image: Convert

Converts an image from one image type to another.

Image: Convert: To Gray Scale
Image: Convert: To Indexed 256
Image: Convert: To True Color 



Image: Convert: To Gray Scale

Converts the image to 8-bit gray scale. No arguments are needed.



Image: Convert: To Indexed 256

Converts the image to the indexed 256 format. When converting from gray 
scale no arguments are needed: the indexed image's palette is set to the 
256 shades of gray. 

When converting from color, you are asked to choose between medium 
quality (pattern dither using a system palette) or high quality (using a 
diffusion dither and adaptive palette).    Note: If you do not have a 24 bit 
graphics card Matisse will use a dithered display and you will not be able to 
visually see any difference between the two images while in the program.    
However, if you use a different application which resets the system palette, 
or if you try it on a 24 bit display, the image will show up at superior quality.



Image: Convert: To True Color
 
Converts the image to True 24 bit color.



Image: Crop

Crops the image to the current marquee.



Image: Flip

Flips the entire window (including all objects) either horizontally or vertically.



Image: Rotate 90

Rotates the entire window (including all objects) by 90 degrees.



Image: Resample

Resamples the entire window (including all objects) to a given new width and
height. These can be entered in either in pixels, inches, or as percent of the 
original image. You can also constrain the aspect ratio to be fixed to the 
aspect ratio of the old image.



Image: AutoPaint

This switch toggles on auto painting mode.    With AutoPaint, when the brush 
tool is active the right mouse button causes    Matisse to automatically fill the
image using the last brush stroke.    (Normally the right mouse button simply 
repeats the last stroke once). 



The Object Menu

The Object Menu contains commands that used for selecting, grouping and 
aligning objects on the screen. 

Object: Make Floating
Object: Merge
Object: Merge Control
Object: Select All
Object: Select None
Object: Delete
Object: Flip
Object: Soften
Object: Set Outline
Object: Set Interior
Object: Group
Object: UnGroup
Object: Order
Object: Snap To Grid
Object: Align
Object: Align To Image
Object Location
Object Opacity



 
Object: Make Floating(Ctrl+O)

Creates a "floating" image object by copying the bits under the current 
Marquee. 



Object: Merge (Ctrl+M)

Merges all selected objects onto the composite. When an object is merged all
of its pixels are copied to the background image, and the object information 
is lost.



Object: Select All (Ctrl+X)

Selects all objects in the active Window. Do not confuse it with the Select All 
command in the Edit Menu which is used for selecting a Marquee.



Object: Select None(Ctrl+Z)

Deselects all objects in the active Window. Do not confuse it with the Select 
None command in the Edit Menu which is used for selecting a Marquee.



Object: Delete (Del)

Deletes all the currently selected Objects in the active Window.



Object: Flip

Flips selected objects, either horizontally or vertically. If you wish to flip the 
entire image, use the Image: Flip command.

See also: Image: Flip



Object: Merge Control

Sets the merge control options that apply to the top-most selected object. 
These options depend on the type of    object: image, shape or text. 

For image objects there exists a checkbox allowing you to specify that the 
image is a Transparency, i.e.: that its background is non-opaque. 
Transparencies are handy for "writing" on top of another image and for other 
effects.

For shape objects, a different checkbox allows you to turn off the drawing of 
borders. This is useful for creating crisp filled shapes with no outline.

For Text objects, a text entry box and font selector are provided.

For all objects, you can select the compositing rule that determines how the 
object is merged onto other objects beneath it.



Object: Soften

Softens the edges of an object. Matisse does this by applying a blur filter to 
the selection mask defining the object.    The soft-edge amount is given in 
pixels.



Object: Group (Ctrl+G)

Unifies selected objects so that they move as one.    You can have groups of 
groups and so on...    To undo the group use the Object: UnGroup command

See Also: Object: UnGroup. 



Object: UnGroup (Ctrl+U)

This command is used to diss-associate grouped objects.

See Also: Object: Group.



Object: Order

These commands change the older of    objects on the desktop

Object: Order: Send To Front
Object: Order: Send To Back
Object: Order: Move Up
Object: Order: Move Down



Object: Order: Send To Front (Ctrl+F)

Sends the current selected objects to the top of the desktop.



Object: Order: Send To Back (Ctrl+K)

Sends the current selected objects to the back of the desktop.



Object: Order: MoveUp 

Moves the selected objects up one layer on the desktop.



Object: Order: Move Down

Moves the selected objects down one layer in the desktop



Object: Location (Version 1.2)

This command brings up a popup menu allowing you to "remember" the 
position of an object and to "restore" the object to that position.    
Alternatively, you can use the Home key to restore an object to it's 
remembered position..



Object: Snap To Grid

Toggles Snap to Grid Mode.    When Snap to Grid is checked all objects, 
marquees etc.. snap to fixed grid points when moved.



Object: Align

Aligns a set of objects relative to each other.    For instance, selecting Align 
Left will cause all selected to be left-aligned to the left-most object. 

Since the align command tends to be used frequently, we have assigned the 
following easy-to-remember keyboard accelerators:

CTRL+L Object: Align:   L  eft  
CTRL+R Object: Align   R  ight  
CTRL+T Object: Align   T  op  
CTRL+B Object: Align   B  ottom  
CTRL+C Object: Align   C  enter  

The Shift versions of these accelerators are used for the Align To Image 
commands.
 
See Also: Object: Align to Image.



Object: Align: Left

Aligns selected objects to the left side of the bounding rectangle.



Object: Align: Right

Aligns selected objects to the right side of the bounding rectangle



Object: Align: Top

Aligns selected objects to the top side of the bounding rectangle.



Object: Align: Bottom

Aligns selected objects to the bottom side of the bounding rectangle.



Object: Align: Center

Aligns selected objects to the center of the bounding rectangle.



Object: Align To Image: Left

Aligns selected objects to the left side of the image.



Object: Align To Image: Right

Aligns selected objects to the right side of the image.



Object: Align To Image: Top

Aligns selected objects to the top side of the image.



Object: Align To Image: Bottom

Aligns selected objects to the bottom side of the image.



Object: Align To Image : Center

Aligns selected objects to the center of the image.



Object: Align To Image

These commands are used to align a set of objects to the edges of the image
window.

Since these command tends to be used frequently, we have assigned the 
following easy-to-remember keyboard accelerators:

CTRL+SHIFT+L Object: Align To Image:   L  eft  
CTRL+SHIFT+R Object: Align To Image:   R  ight  
CTRL+SHIFT+T Object: Align To Image:   T  op  
CTRL+SHIFT+B Object: Align To Image:   B  ottom  
CTRL+SHIFT+C Object: Align To Image:   C  enter  

See also: Object: Align.



Object: Set Outline (Ctrl+H)

Sets the outline color for shape objects to the current foreground color. It has
no impact on image objects.



Object: Set Interior (Ctrl+I)

Sets the interior colors of shape objects. If the shape is currently being filled 
with a single color, the command will replace that color with the current 
Foreground Color. If    the shape is being gradient filled, the current 
Background and Foreground colors will define new gradient fill colors.



Object: Opacity (Version 1.2)

This submenu contains 4 commands which effect the "Opacity layer" of an 
object.    The Opacity layer records how "opaque" the object is at every pixel.

Opacity Import Imports an external image as the current opacity layer
Opacity Export Exports the opacity layer as a gray scale image
Opacity Fill Fills the opacity layer to a given value.
Opacity Invert Inverts the opacity layer.

Note: All these commands work only if a single object is selected.    Also, the 
opacity fill command, like the regular command is clipped to the current 
marquee.    So if you make the current marquee a circle marquee and then fill
to transparent inside that marquee, the result will be to "burn" a hole in the 
object.



The View Menu

The View Menu allows you to control which element of the Matisse window is 
visible at any one time.    For instance, you can hide the toolbox or the status 
bar by toggling the appropriate settings.    The menu also contains standard 
zooming commands.

View: Zoom In
View: Zoom Out
View: Actual View
View: Fit to Window
View: Information
View: Brush Box
View: Brush Shape
View: Brush Options
View: Color Selector
View: Current Pattern
View: Current Texture
View: Toolbox
View: Status Bar
View Ribbon (Version 1.2)



View: Zoom In

Zooms in. Zoom factor varies from 1 to 16.



View: Zoom Out

Zoom out. Zoom factor varies from 1 to 0.06 (One Sixteenth).



View: Actual View

Sets Zoom Factor to 1:1 (Actual view)



View: Fit to Window

Resets the Window so that the image fits tightly.



View: Information

Displays a window showing information on the active image.



View: Brush Box

Shows/Hides the Brush Box.



View: Brush Shape

Shows/Hides the Brush Shape Box



View: Brush Options

Shows/Hides the Brush Options Box



View: Color Picker

Shows / Hides the Color Picker



View: Current Pattern

Shows/Hides the Current Pattern. Note: The current pattern window is not 
editable.



View: Current Texture

Shows/Hides the Current Texture. Note: The current texture window is not 
editable.



View: Toolbar

Shows/Hides the Toolbar.



View: Status Bar

Shows/Hides the Status Bar



 
View: Ribbon (Version 1.2)

This command displays a ribbon with the following controls:

Control Meaning
-------- ---------
"A" Button Marquee Select All
"N" Button Marquee Select None
"I" Button Marquee Select Invert
"Float" Button Object Make Floating
"Marquee" Button Object Make Marquee
Combo Box Composite Rule (from Object Options)
Slider        Opacity (from Object Options)
"T" Check Transparency Mode (from Object Options)
"Undo" Edit: Undo
"Clear" Edit: Clear



The Window Menu

Window: Cascade
Window: Tile
Window: Arrange Icons



Window: Cascade (Shift+F5)

Cascades all open windows so that they are neatly arranged.



Window: Tile (Shift+F4)

Tiles the entire matisse window with all open windows.



Window: Arrange Icons

Arranges all icons at the bottom of the screen.



 
Help

This help facility.



Keyboard Accelerators

These keyboard sequences can be used to replace Matisse's Menu 
commands.

CTRL+A Edit: Marquee All
CTRL+B Object: Align : Bottom
CTRL+SHIFT+B Object:: AlignToImage:Bottom
CTRL+C Object: Align : Center
CTRL+SHIFT+C Object: Align to Image: Center
CTRL+D Edit: Marquee None
CTRL+F Object: Order: Send to Front
CTRL+G Object: Group
CTRL+H Object: Set Outline
CTRL+I Object: Set Interior
CTRL+K Object: Order: Send to Back
CTRL+L Object: Align : Left
CTRL+SHIFT+L Object: Align to Image: Left
CTRL+M Object: Merge
CTRL+O Object: Make Floating
CTRL+P File: Print
CTRL+R Object: Align: Right
CTRL+SHIFT+R Object: Align to Image: Right
CTRL+T Object: Align: Top
CTRL+SHIFT+T Object: Align to Image: Top
CTRL+U Object: Ungroup
CTRL+X Object: Select All
CTRL+Z Object: Select None

CTRL+DEL Edit:Clear
CTRL+INS Edit:Copy
SHIFT+DEL Edit:Cut
SHIFT+INS Edit:Paste

F1 Help
F2 File:Save
F3 File:Close
F4 File:Save All
SHIFT+F5 Window: Cascade
SHIFT+F4 Window: Tile

Version 1.2 Additions:

Cursor Keys Move Objects by Grid Size



SHIFT+Cursor Move Objects by 5*Grid Size
Tab Keys Tab between Objects
Home Key Moves Object Back to Last Remembered Position





Version 1.2: New Features

The following new features were included in Version 1.2 and are not 
documented
in the manual.    They appear in red elsewhere in this online manual.

Photo-CD support
Automatic detection of WinTab capability, allowing Kurta tablet support.
A "Quill" brush which varies in size with pressure
A "Japanese" watercolor brush
A "Chameleon" brush which changes color with pressure
A "Make Marquee" command.
Opacity cmmands for better control of the alpha layer.
Object position remember and restore commands.
Ability to tab between selected objects.
Ability to move objects with the cursor keys.
A "Paste as New Document" feature.
A "Clear Clipboard" command.
A Ribbon for quick access to frequently used commands such as Marquee 
None.
New preferences including brush cursor and pressure options.
An improved "Additive" merge mode allowing lighting effects.
New, non-repeating textures including leaves and grass. 
A new "Surface" brush for airbrushing texture onto the canvas.
Improved shape and gradient tools.
New preset palettes such as "Santa Fe" for palette gradient fills and image
colorization.



Chapter 1: Welcome To Matisse

1.1 Overview
2.2 System Requirements
1.3 Memory



 
1.1 Overview

Matisse is a Paint and Image Processing program that is built around the 
concept of objects. An object can be an image, a shape or a paragraph of 
text. It can sit on top of other objects, blend into them, be resized, rotated or 
distorted. The result is that you can produce in minutes photo-paint 
compositions that would take hours in other packages, if you could do them 
at all.

Tremendous research has gone into making Matisse's brushes perform like 
their natural counterparts. Aspects such as paper texture, grain control, 
blackness, smoothing and scatter have been incorporated into the design. 
On the other hand, we have tried to limit the number of brush controls to 
avoid the feeling of overload.

Experienced photo-retouching and paint program users will recognize many 
of these standard tools, such as the Marquee Tool. Whenever possible we 
have tried to remain backward compatible with existing standards to avoid 
confusion.



1.2 System Requirements

In order to run Matisse, you need at a minimum:

an Intel-386 or 486 based Computer.
4MB of Ram
SVGA Color Monitor
Windows 3.1

If you have Windows 3.0 you can upgrade to 3.1 for a very low cost. Besides 
being generally more stable than 3.0, the newer version allows you to use 
"True Type" fonts, which a becoming the de-facto standard.

If you are serious about your graphics, you may want to consider the 
following additional investments:

Get a good font pack. For under $50 you can add 50 to 100 new True Type 
fonts to your system. There is no reason to be limiting yourself to Times 
Roman or Arial. 

Upgrade to a 486 machine, preferably 33Mhz or faster.    The additional speed
will make the brushes really perform.    At a minimum, add a math 
coprocessor chip to your 386.

Get a 24-bit card. The 24-bit card will completely eliminate the dithered look 
on your screen.    Images will appear with photographic crispness. 

Get more memory.    8Mb is plenty for working at screen resolutions (see 
Memory), but if your ultimate goal is 300 dpi output,    you will want at least 
16 Mb,    and possibly more.

Get a flatbed scanner.    The quality of these machines is unbelievable,    
some of them picking up detail at 600 dpi.    Adding a scanner to your system
will change the way you think of images forever. 

Get a color laser printer.    Although the cost is coming down,    high quality 
color printing is still very expensive.    Many of the more affordable systems 
have one or more irritating drawbacks.    Before you make the plunge,    make
sure you are satisfied with the quality of the output.

Get a CD drive.    Fauve Matisse now supports Photo-CD.    The great 
advantage of Photo-CD is that it bypasses the scanning step, allowing for 
quick, inexpensive image aquisition.



1.3 Memory

In order to optimize your use of    Matisse, it helps to have some 
understanding of memory - both what's available under Windows and what 
you need to work with. 

The good news is that, Unlike DOS, Windows supports virtual memory. In 
theory, this means that you can address up to four times the physical 
memory on your system. In practice, the factor is closer to two times, after 
accounting for DOS, Windows and Matisse. For instance, if you have 8Mb 
installed on your system, you probably have around 16-17 Mb of available 
memory. The exact number is shown at the bottom of the Matisse Status Bar.

Now for the bad news: Imaging is very memory intensive. For the purpose of 
example, lets use a standard snapshot size of 3.5 x 4.75 inches. At a typical 
screen resolution of 70 dots per inch this image contains about 80,000 pixels
and will require about 560K of memory, allowing for undo and clipping 
operations. In other words, an 8Mb system can "hold" up to 28 snapshot size 
images at a time. So, as long as you are working at screen resolutions 8Mb 
will generally be more than enough.

On the other hand, the minute you get into 300 dpi or more images, the 
memory requirements start adding up. The same snapshot at 300 dpi will 
require about 10MB of memory, or almost 18 times as much as at screen 
resolution. Bottom line - if you are working at printer quality resolutions you 
need a lot of memory: at least 16MB





Chapter 2: Getting Started With Image Files

2.1 Color, Gray Scale and Indexed 256 Images
2.2 Image File Formats
2.3 Opening and Saving Images
2.4 Zooming, Scrolling and Iconifying Images



 
2.1 Color, Gray Scale and Indexed 256 Images

Matisse supports three distinct types of images: Color, Gray Scale and 
Indexed 256. Most the time, you will simply deal with "True" Color images. 
However, if you are ultimately interested in gray-scale printed output, you 
may decide to work in gray scale. Finally, Matisse supports an older type of 
image called "Indexed 256". While this image type is slowly being phased 
out, you may still run across it if you are downloading GIF and other files.

True Color is the standard 24-bit type used to represent color images. Each 
color is identified by three numbers between 0 and 255 representing the 
Red, Green and Blue components of that color.

Gray Scale images are 8 bit images where every pixel is represented by a 
number between 0 ( black) and 255 (white). All the filters and paint 
operations apply directly to gray scale images.

Indexed 256 images are 8    bit images with each pixel being coded as an 
index between 0 and 255. This index is used as a lookup into a fixed 
"palette" or table of    RGB colors. For instance, the index 233 might 
correspond to the color R=123, G=56, B=129. This palette is saved with the 
image. 

Indexed 256 images have two main advantages. First, they are relatively 
small, requiring only byte of information per pixel. Second, they allow images
to be displayed in high quality on VGA and SVGA displays, assuming that the 
system palette is reset to match the palette of the image. 

Unfortunately they also have some serious drawbacks. They are inherently 
ill-suited for painting and image-editing both which require a 24-bit internal 
description of the image. Furthermore, resetting the system palette to 
display an image is only really feasible if you are displaying one image at a 
time. Otherwise, you will experience total loss of color on the other images, 
excessive flicker and delays as the system "rotates" between palettes. 
Consequently, Matisse has opted to not to take advantage of this "feature" 
on 8-bit displays. Note: Although we support indexed 256 color as a type, 
you must first convert the image to True color if you want to edit it.



2.2 Image File Formats

Image files are stored on disk in various file formats. In order to import a file 
into another program such as Microsoft Word you will need to save it in a file 
format that is supported by that program. 

Matisse Format (.MAT) This format is the only one that fully recognizes all 
the different types of    objects (images, shapes and text) that you can use in 
Matisse.    You should use it to save all your work in progress.

Tagged Image Format (.TIF) A format developed by Aldus and Microsoft 
and recognized by most applications including all major draw and 
presentation packages.    TIFF comes in two varieties, compressed and non-
compressed.    The compressed variant uses the so called LZW compression 
scheme that allows space savings without any loss of image quality.

Joint Photographic Experts Group Format (.JPG) This format is rapidly 
becoming the standard for compressed images.    JPEG can compress an 
image up to 100 times, albeit with some loss of image quality.    Use this 
format for archiving large images.    Do not use it for work in progress, as 
there is some loss at each compression and decompression cycle.

Windows Bitmap (.BMP) This is    the standard Microsoft/OS2 Bitmap 
format, and is used internally for copying to the MS clipboard.    As all the 
other formats described here , it is "device independent," not linked in any 
way to a specific type of display monitor.

Encapsulated Postscript (.EPS) This is the Adobe format, required by 
postscript printers.    It is a good choice for sending your output to a service 
bureau or communicating with Macintosh desktop publishing programs.

Graphic Interchange Format (.GIF) GIF is the main Compuserve format.    
It does not support 24 bit color and does not record the image resolution.    
Use this file format to send indexed images over the Compuserve network.

PC Paintbrush (PCX) The ZSoft format, developed for the entry level 
package PC Paintbrush. 



 
2.3 Opening and Saving Images

The commands for opening and saving images are located in the File Menu. 
These commands are:

File: New: Image    Creates a new color or gray scale image.
File: Open : Image    Opens an image from disk.
File: Save Saves the active image.
File: Save As Saves the active image under a new name.
File: Save All    Saves all active images.



2.4 Zooming, Scrolling and Iconifying Images

When    you bring up an image, the image is contained in its own image 
window. This window contains a Title Bar which lists the name of the image 
file and the zoom factor. A zoom factor of 100% indicates a full-scale image. 
The zoom factor can be changed either with the Zoom Tool or with the Zoom 
Factor commands on the View Menu. 

When an image is zoomed, or is otherwise too big to fit in the current window
vertical and/or horizontal scroll bars will appear to allow you to edit the 
image one part at a time. You can also use the Hand Tool to auto scroll or 
"pan" around the image.

Like any Microsoft window, an image window can be maximized or 
minimized. When minimized, the image is replaced with a thumbnail slide, or
"Icon". You can specify the size of these icons using the File: Preferences: 
Icon Size command. 





Chapter 3: Mastering The Toolbox

3.1 Toolbox Overview
3.2 Selection Tool
3.3 Marquee Tools
3.4 DistortTools
3.5 Zoom Tool
3.6 BrushTool
3.7 Fill Tools
3.8 Shape Tools
3.9 Text Tool
3.10 Hand Tool
3.11 Eyedropper Tool      



3.1 Toolbox Overview

The Matisse toolbox consists of 10 different tool categories, each represented
by a tool icon. Icons which contain a small triangle in the lower left region 
lead to additional "related" tools. For example, the Rectangular Marquee icon
can be pressed down (below the triangle) to reveal three other related tools: 
An Elliptical Marquee, A Lasso    and a Wand.

The toolbar is deceptively simple. Some of the tools, in particular the distort 
tools, apply to objects, a term which is defined in Chapter 7: Working With 
Objects. 



3.2 The Selection Tool (Arrow)

This tool is used to select and move objects. To Select an object click on the 
object with the left mouse button.    This will normally cause all other objects 
to be deselected. If you want instead    to add to the selection hold down the 
Shift key while selecting the object. To toggle the state of an object, hold 
down the Control key while selecting the object.



3.3 The Marquee Tools

These tools are used to define a marquee or clipping area which applies to all
filter and painting operations. Once a marquee is created, the Object: Make 
Floating command can be used to transform the marquee into a floating 
object.        

The Rectangle Marquee Tool is used to create rectangular clipping regions
or objects.    To use the tool, click to anchor the rectangle and then drag to 
create the desired shape.    The rectangle can be constrained to a square by 
holding down the Control key during the operation.

The Ellipse Marquee Tool is used to create elliptical clipping regions or 
objects. To use the tool, click to anchor the ellipse and then drag to create 
the desired shape.    The ellipse can be constrained to a circle by holding 
down the Control key during the operation.

The Wand Tool is used to automatically select out regions which are similar 
in color.
To use the tool, simply click with the wand on any part of an open image. The
wand
will automatically create a connected marquee encompassing all similar 
pixels. The
sensitivity of the tool can be controlled by the wand options dialog box, 
which you can get to by double-clicking on the wand tool icon.

The Lasso Tool is used to select a marquee area free-hand. To use the tool, 
press the left mouse button down to anchor the lasso, and while keeping the 
button down, draw out the outline of the marquee. When you are finished, 
double click to terminate.

Note: You can add to the current marquee by holding down the Shift key 
while applying the marquee tool. If you want to subtract from the current 
marquee, use the Alt key.



3.4 The Distort Tools

The Distort Tools are used to distort and resize objects. The following
tools are available:

The Rotate Tool is used to rotate objects around a given point. To use the 
tool, select it from the Marquee . Handles will appear around each selected 
object and a small cross will appear in each object's center. You can grab the 
handles to rotate the object, or drag the center cross to a different location if 
you want to rotate around an arbitrary point.

The Resize Tool is used to resize a given object. When the tool is active 
handles will appear around selected objects. By grabbing these handles you 
can freely resize each object to the desired dimensions.

The Free Distort Tool is used to freely distort a given object. When the tool 
is active handles will appear around selected objects. By grabbing one of 
these handles you can "pull it" to cause a distorted effect.

The Perspective Tool is used to apply a perspective transformation to a 
given object. When the tool is active handles will appear around selected 
objects. By grabbing one of these handles you can move both it and the 
"opposite" handle in opposite directions. To switch between Vertical and 
Horizontal Perspective use the Shift key.

The Skew Tool is used to apply a Skew transformation to    a given object. 
When the tool is active handles will appear around selected objects. By 
grabbing one of these handles you can move both it and the "opposite" 
handle in the same direction. To switch between Vertical and Horizontal Skew
use the Shift key.

The Reshape Tool is used to edit control points of shape objects. When the 
Reshape Tool is active, the control points and tangents of all selected shapes 
will appear. These points can be dragged to alter the shape of the object. The
Delete key can be used to delete control points, while Shift+Insert can be 
used to add control points.

The Tilt Tool is used to tilt all selected objects in the current window so that 
a specified line appears horizontal. This is particularly useful for 
straightening up an image object which has been scanned in crooked. To use 
it simply locate a horizontal line in the image and trace that line out with the 
tilt tool. 



3.5 The Zoom Tool

The Zoom Tool is used to zoom into or out of a current Image Window. 

Clicking with the left mouse button will zoom in by a factor of two. Clicking 
with the right mouse button will zoom out by a factor of two.



3.6 The Brush Tool

The Brush Tool is used for all types of painting. To select the type of brush 
you wish to paint with, click on an icon in the Brush Box (you can bring up 
this brush box either with the View: Brush Box command or by double-
clicking on the brush tool icon).



3.7 The Fill Tools

The Bucket Fill tool is used for flood-filling a region to the current 
foreground color.
The sensitivity of the fill can be changed by double clicking on the Bucket 
Icon and changing the value of the sensitivity parameter.

The Gradient Fill tool is a versatile tool for filling regions and objects.
By double clicking on the Gradient Fill Icon, you access a dialog box 
controlling the tool's behavior. The following parameters can be changed:

Gradient Shape. This can be Line,    Rectangle or Ellipse. Use Line for linear 
(horizontal, vertical, diagonal) fills, and Rectangle or Ellipse for fills 
emanating from the center of an area or object.

Gradient Colors. Foreground to Background, Background to Foreground or 
Palette Colors. The Palette Colors option is only available if at least one 
palette is open.

Gradient Palette. A dialog box listing all open palettes. Select one of these 
palettes to customize the gradient fill colors. Note: this option is only 
available if at least one palette is open.

Gradient Opacity. The Opacity of the fill. Use an opacity of less than 100 to 
overlay a color gradient fill on-top of an existing image.

Gradient Repeat. Controls how many times the gradient fill will be repeated 
outside of the defining area. Choose a repeat factor greater than 1 to create 
repeating "psychedelic-art" type fills.

Gradient Midpoint. Controls how fast the fill is done from background to 
foreground (or vice versa). It has no impact on palette fills.

Gradient Smooth Fill. Check this box for the usual (smooth) gradient fill. 
Leaving it unchecked will result in a "banded look".

Gradient Extrapolate. Check this box if you wish to extrapolate beyond the 
defining area.

Gradient Repeat. Check this box if you wish to alternate the repeating 
gradient fills: e.g. Back->Fore, Fore->Back etc. 

Gradient Cross Fade. Check this box if you wish to impact the opacity layer of
an object as opposed to an image layer. This is desirable if you wish to create



gradient cross fades of one image into another. Note: this feature only 
impacts objects,    not the background image.



3.8 The Shape Tools

The Shape Tools are used for creating Shape Objects.The following tools are 
included:

Rectangle Shape Tool. Used for Creating Rectangular Shapes. Can be 
constrained to create Square shapes by holding down the Shift Key.

Round Rectangle Shape Tool. Used for Creating Rectangle Shapes with 
Rounded Corners. Can be constrained to create Rounded Squares by holding 
down the Shift Key.

Ellipse Shape Tool. Used for Creating Ellipse Shapes. Can be constrained to 
create Circle Shapes by holding down the Shift Key.

Filled Spline Shape Tool. Used for Creating Filled Spline Shapes. These shapes
typically start out as "blobs" but can be reshaped into virtually any shape 
using the Reshape Tool.

Polygon Shape Tool. Used for Creating Polygons. These are nothing more 
than filled Splines with the tangent vectors set to zero.

Line Shape Tool. Used for Creating Lines. 

Polyline Shape Tool.Used for Creating Polylines - i.e.: a series of line 
segments.



3.9 The Text Tool

The Text tool is used for creating Text Objects. To activate the tool, click 
anywhere in a window. A specialized version of the Object Options box will 
appear allowing you to enter paragraph text. You can select any True Type 
font that you have installed on your system. You can also specify whether the
text is to be left, center or right aligned. 

At any point in time you can edit the text in a text object or change the font 
simply by double clicking on the object to bring up the dialog box.

One of the options in the Text tool dialog box is a checkbox called "Printer 
Quality". Checking this box will force the text to be printed at the resolution 
of the printer, resulting in vastly superior printed quality (versus screen 
resolutions). The only drawback is checking this option disables compositing, 
gradient fills of text, rotation, distortion and other features which would 
normally apply. Bottom line - if you are going to print your image, check this 
box; if not, don't.



3.10 The Hand Tool

The Hand Tool is used for panning around images which have vertical and/or  
horizontal scroll bars. The tool has no effect if no scroll bars are active. 



3.11 The Eyedropper Tool

The Eyedropper tool is used for selecting colors from an image. Clicking on 
an image with the Eyedropper causes the foreground color to change to the 
color that is underneath the cursor. In order to compensate for random noise,
Matisse allows you to specify an averaging radius for this color 
determination. If the radius is greater than 1,
every pixel within that radius will be averaged to get the color. The radius is 
set in the Eyedropper dialog by double clicking on the Eyedropper Icon

 When the Eyedropper is active, the R, G and B values for the current pixel 
are displayed on the Status Bar. 

Note: The Eyedropper works both on images and palettes. For palettes, the 
Right mouse button of the Eyedropper has the effect of "dropping" (the 
opposite of the Left Mouse Button).





Chapter 4: Standard Brushes

4.1 DrawTools
4.2 Paint Tools
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4.5 Opacity Brushes



4.1 Draw Tools

Pencil.    A smooth, opaque pencil for sketching.

Calligraphy Pen.    An angled, tightly spaced rectangular quill, for fancy 
lettering.

Felt-tip Pen.    A "dirty" felt tip pen, which darkens when you go over it 
repeatedly.

Quill Pen.    (Version 1.2):A "pen and ink" tool which varies smoothly in size as
pressure increases.    Requires Pressure Tablet.

Charcoal.    A highly textured brush that simulates the touch of charcoal.

Crayon.    A standard, waxy crayon, similar to the ones you used when you 
first learned to draw.

One Pixel Pencil.    A precision pencil for detailed work at the pixel level.



4.2 Paint Tools

Airbrush.    A brush for applying a fine mist of paint.

Oil.    A rich, creamy multi-tipped brush.    Use it to create your own 
"Sunflowers" at a fraction of the cost.

Water colors.    A semi-transparent medium characterized by a high degree of 
"bleeding." 

Pastels.  A chalky, grainy brush.

Pointillist.  A neo-impressionistic style brush for drawing landscapes, trees, 
etc. 

Fauve.    A totally wild brush for the true Fauve artist.    In French, fauve 
means wild beast, and it was the name of the school to which Matisse 
belonged.
 
Cubist.  A brush in the style of Braque or Picasso. 

Surface.    (Version 1.2) A textured airbrush, perfect for applying surface 
texture to the canvas.

Japanese. (Version 1.2) An oriental watercolor brush whcih varies in size with 
pressure. Requires Pressure Tablet.

Chameleon (Version 1.2)  A brush which varies in color between the 
background and foreground colors depending on pressure. Requires Pressure 
Tablet.



4.3 Stamp Tools

Stamp tools are    brushes that copy one part of an image to another part of a
(possibly different) image. 

Transfer.    A    straight copying tool.

Felt Tip.    A "dirty," felt-tip stamp tool for creating blackened copies of 
images.

Stroke.    Copies, using an oil paint brush. 

Dots.    Pointillist stamp. Instant neo-impressionistic art.    (Handle with care.    
May result in a case of measles.)

Airbrush: Fine mist stamp for creating "ghost" effects.

To use a stamp tool: 

1. Open the image you wish to stamp from, and click with the left mouse 
while holding down the Shift key.    This will "anchor" the stamp.

2. Open an image onto which you wish to stamp. (This may be the same 
image.)

3. Paint on the target image,    as with any brush.    Matisse will "pick up" 
pixels from the source image and copy them as you go. 



4.4 Retouch Tools

These brushes are primarily used for retouching photographic images.    A 
bad snapshot can be "saved" by careful application of these brushes.    
Retouch tools can also be used in painting to create special effects.

Lighten.    Lightens the area under the cursor. 

Darken.    Darkens the area under the cursor.

Smudge.    "Finger Painting" tool.    Picks up paint and smudges it as it goes. 

Blur.    Useful for softening edges locally.

Diffuse.    Good for giving a hint of randomness. 

Despeckle.    Digital detergent. (Cleaner than clean.) Removes small spots.

Mosaic.    Applies the mosaic filter to the pixels directly under the brush. 

Add Noise.  Adds noise as you go.



4.5 Opacity Brushes

Opacity brushes remove or restore opacity as they are applied.    By removing
opacity, we create "holes" in an object that lets the background "shine 
through."    Conversely, by using the opacity restore brush, we undo the 
holes, and restore the original object.

Remove Opacity.  Removes opacity from an image object.    Used in zoomed 
mode to define precisely the borders of image objects.

Restore Opacity.    Undoes the effect of "remove opacity."    

Blur Opacity.      Softens the edges of an image object as it is applied.

Remove One Opacity.    A one pixel variant of the "remove opacity," for 
defining the edges of objects in a close, highly detailed manner.

Restore One Opacity.    The converse of the "remove one opacity" brush.





Chapter 5: Customizing your Brushes

5.1 The Brush Shape Box
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5.5 Retouch Options
5.6 Editing Brush Sets



5.1 The Brush Shape Box

The first thing you will want to change with you brushes is to change their 
size. To do this you need to make sure the Brush Shape Box is visible (use 
the View: Brush Shape command to show it). The following controls are 
available:

Brush Size: Sets the current brush radius in pixels.

Brush Aspect: Defines the brush aspect ratio i.e.: the ratio of the brush 
height to the brush width. The smaller this number, the more elliptical round 
brushes will appear.

Brush Angle: Allows you to have angled brushes. Great for calligraphy and 
"ribbon" effects.

Brush Soft Edge: Controls the "softness" of the brush edge. The greater 
this number, the more "Airbrush"-like the brush will appear.

Number of Tips: Controls how many brush tips are in use. Typically this is 
set to one, although you can have more than one tip, in particular if you want
to create thick, "oil" effects.

Square Tip: Sets the brush tip to "square" as opposed to "round". This is 
useful for precision work at the pixel level.

Anti-Alias Box: This checkbox turns on and off anti-aliasing for the brush. 
Usually you will want to leave it on, although for detailed work with square 
brushes you might prefer to disable it.



5.2 The Brush Options Box

The Brush Options Box controls the behavior of an individual brush. It 
contains for instance, controls on the spacing and opacity of the paint dabs. 
Any changes you make in this box will only affect the current brush.

At the top of the Brush Options Box a combo box allows you to choose 
between three types of brushes: standard paintbrushes, brushes used for 
cloning or "stamp tools", and finally a specialized category of "retouch tools".
Depending on which of these three options you choose, a different set of 
sliders will appear.



5.3 Paintbrush Options

Opacity: The overall opacity of the paint. At 20% opacity, each dab of the 
paint will apply 20% of color to the background.

Spacing: The spacing between successive dabs of paint. Is measured 
relative to the size of the brush. For example, if the brush size is 10 pixels, a 
spacing setting of 50% implies that there are 50% x 10 = 5 pixels between 
each dab. You can generally leave the spacing at around 20% for most 
brushes. Small spacing will slow down the brush.

Smoothing: Applies a smoothing algorithm to the brush path. This allows 
you to create very smooth strokes, even with a standard mouse. On the 
other hand, the higher the smoothing value, the less control you will have 
with mouse. Also, you generally don't need quite as much smoothing with a 
tablet as with a mouse.

Scatter : Randomly scatters successive brush strokes, giving a "pointillist" 
neo-impressionist look.

Grain: This control affects the outer-rim of the brush, giving a "shredded 
fringe" look to your brush strokes. It is sensitive to the type of paper texture 
in effect.

Texture: Picks up the underlying paper texture. When combined with the 
grain control, can give a very natural look to your brush strokes.

Bleed: Effects how the colors of the brush "bleed" into the colors that are 
already on the canvas. If bleed is set at a high level, the strokes will be very 
diluted, as with a watercolor brush.

Blackness: Effects how the colors "burn in" to the background. When 
blackness is zero, the blending is a strict (additive) opacity blend. This 
mimics the way oil paints tend to blend. On the other hand, setting blackness
close to 100% results a subtractive blending which is closer to the way inks 
blend.

Randomization Controls: These controls randomize the colors of each dab 
of paint. You can choose to randomize using either the RGB, HLS or CMYK 
models. If, for instance, you choose the RGB model, each of the r, g and b 
channels would be continuously randomized according to the sliders.

Pressure Sensitivity Controls: These controls take the form of three menu
check items which are used to turn on or off    pressure-sensitive behavior. 



They only apply when you have a pressure sensitive tablet installed.

Increase Opacity increases the opacity when pressure is increased.
Increase Blackness increases blackness when pressure is increased.
Increase Scatter increases scatter when pressure is increased.    
Change Size.    (Version 1.2) increases size when pressure is increased.
Change Color    (Version 1.2) changes color from foreground to background 
with pressure.



Speed Sensitivity Controls: Like the pressure sensitivity controls, these 
controls take the form of three menu check items which are used to turn on 
or off    speed-sensitive behavior.

Decrease Opacity decreases the opacity when brush speed is increased.
Decrease Blackness decreases blackness when brush speed is increased.
Decrease Scatter decreases scatter when brush speed is increased. 



 

5.4 Stamp Options

Stamp options effect the behavior of Stamp Tools. See Chapter 4. for a 
description of the standard stamp tools.

Align: When this option is checked, the cloning is always done relative to the
anchor point, regardless of whether the mouse is down or not. You want this 
checked if    you cloning a large part of an image, you want it unchecked if 
you are cloning multiple copies of the same thing at different places.

Align To Page: This option forces the cloning to be done page-to-page. You 
want to check this option if you are cloning an entire image. In this mode, 
first use File: Duplicate to duplicate the image. You can then either clear the 
clone image with Edit: Clear, or create a "semi-transparent" layer using the 
following commands:

Edit: Select All
Object: Make Object
Object: Options            Opacity 50%
Edit: Clear 

Average: When averaging is turned on the pixels underneath the cloning 
source brush are averaged to produce the painting color. This feature is 
useful for creating "painterly" clones out of    ordinary images.

Repeat: When the cloner is "outside" of the source image, it typically ceases
to clone. To override this behavior, and continue cloning as in a pattern fill, 
turn the Repeat switch on.



5.5 Retouch Options

The Retouch Options contain a selector which make the brush behave like a 
specialized retouch tool. See chapter 4.0 for a description of the retouch 
tools. A slider is available to modulate the strength of each tool. This is fairly 
self explanatory, except for the Mosaic tool, where "Strength" has the 
interpretation as "tile size".



5.6 Editing Brush Sets

If you change a brush parameter using the brush options box, and then 
switch to another brush, Matisse will ask you if you want to save the 
changes. If you say yes, Matisse will register the brush set as "changed" and 
at the end of the program prompt you for a filename to save it under. You 
can then overwrite the default brush file (matisse.brs) or create your own 
brush file under the name you choose.

When Matisse starts up the next time, you can open your saved brush set by 
using the Edit: Brushes: Open command. You will also find other easy to 
understand editing commands in the Edit: Brushes sub menu .

See also: Edit: Brushes
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6.1 Color Models

In order to classify colors, researchers have come up with a number of 
different "models" or "color spaces". Matisse supports the three most 
frequently used of these:

The RGB model breaks up each color into Red, Green and Blue components. 
This color model is used internally by all computer programs, and reflects the
way light beams "add together" in a cathode ray tube. 

The HLS model is a more intuitive classification, breaking each color into hue 
(dominant wavelength),    luminosity (brightness) and    saturation(degree of 
purity).

Finally, the CMYK model, splits color into Cyan, Magenta, Yellow and Black 
channels. Since this model mimics the way inks "subtract" out light when 
mixed, it is the standard model in the printing industry.



6.2 The Color Selector

The Color Selector allows you to select colors based on one of three most 
popular color models: RGB, CMYK and HLS. You can also specify gray-levels 
directly. 

For a given color model, you can select the active color either using the 
sliders or by clicking on a color swatch.



6.3 Palettes

In addition to the color selector, you can select colors from a palette. In 
Matisse, a palette is a rectangular array of color swatches, each of which can
have a name up to 21 characters long. The only restriction on palettes is that
they cannot contain more than 5000 colors. 



6.4 Opening and Closing Palettes

Palettes are saved as files with .pal extensions. The File: New, File: Open, and
File: Save commands all work for palettes exactly as they work for images. 
Palettes can be minimized and stored in folders along with images.



 
6.5 Changing the Colors in a Palette

When the cursor is over a palette, the eyedropper tool becomes 
automatically active. Clicking with the left mouse button will "pick up" color 
from the palette, and change the active color. Clicking with the right mouse 
will "drop" the active color into the palette. If you have a middle mouse, it is 
used to drop "a bit" of the active color.

You can select rectangular regions of the palette by holding down and 
dragging with the left mouse button. This selected area can be cut or copied 
and then pasted onto another area or another palette. You can also use the 
Edit: Palette: Interpolate and
Edit: Palette: Rectangle Interpolate commands to interpolate within the 
selected area. 



6.6 Searching a Palette

Palettes can be viewed in two modes: with or without names. The Edit: 
Palette: Names command toggles between these modes. If you have named 
the colors in your palette, you can look up a color by name using the Edit: 
Palette: Find By Name command.

Alternatively, you can use the Edit: Palette: Find command to match the 
foreground color to the nearest color in your palette. Note that if you have 
too few colors in your palette the results can sometimes be unexpected: 
what the computer thinks of    as "nearest color" may not be your top choice.



6.7 Creating a Palette From an Image

One of the most powerful commands relating to palettes is the Edit: Palette: 
Sample Image command.    Applying this command automatically creates a 
16x16 color palette out of an image, by extracting out the top 256 
"representative" colors. 

Once you have such a palette you can turn around and apply the Image: 
Tune: Colorize command to colorize another image.



6.8 Resizing a Palette

The default palette size is 16x16 (256 colors). You can resize a palette to an 
arbitrary number of rows and columns using the Edit: Palette: Resize 
command.
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7.1 Objects: an Overview

One of the things that makes Matisse very different from other Paint and 
Image processing programs is its support of objects. 

If you have used a paint program before, you are already familiar with the 
concept of    "floating selections", which float in a separate layer on top of   
a background image. Matisse pushes this concept one step further, allowing 
you to have any number of    "independent" image objects floating on top of 
the background (and each other). In addition to Images, both Text and Shape
objects are implemented in one unified fashion.

The power of objects is that they can easily be grouped, aligned, resized, 
rotated, distorted and even dragged between Windows. The order of the 
objects on the desktop can be changed. Finally the way objects are 
composited one on top of another can be to create "ghosting" and other 
effects. 



7.2 Image Objects

Image objects are very similar to the concept of    "floating selections" in 
other paint packages. They appear as "pieces" of images that "float" above 
the background. To create an Image Object, first use one of the Marquee 
Tools to define a current Marquee. Then, apply the Object: Make 
Floating(Ctrl+0) command to turn that Marquee into an object.

All Image Objects have a hidden "Opacity layer". This is nothing more than a 
gray scale image which tells Matisse which parts of the object are 
transparent and which parts can be painted on. One of the most powerful 
aspects of the program is the ability to indirectly edit this layer using one of 
the Opacity Brushes These tools allow you to easily and precisely define the 
boundaries of free-form image objects in a way that it is close to impossible 
with the traditional lasso tool. Furthermore, the Gradient Fill Tool has an 
option which will apply the fill directly to the opacity layer allowing you to 
create ultra-quick cross fades.



7.3 Shape Objects

Shapes are objects such as rectangles, circles and curves. They are initially 
created with the the shape tools on the toolbox. Like all objects they can be 
moved, resized and distorted. They can also be merged into the background 
image with the Object: Merge command. 

Matisse represents every shape internally as a set of control points. By 
changing these control points you can change a circle into a moon, an oval 
or a pie. In fact, you can create virtually any shape you want by altering the 
control points. To see how this done, check out the    topic.

All shapes have an outline, which Matisse will use to draw the border of the 
shape. When a shape is first created, the outline drawing mode is set by the 
current brush and the current foreground color. To change the outline, use 
the Object: Set Outline command. You can suppress the outline by selecting 
No Border in Object: Merge Control.    (Version 1.2) Closed shapes are initially 
created with a "no-border" option, ie: they are drawn without outlines.

Closed shapes such as the circle also have interiors. When the Shape is 
created, its interior is filled to the current background color. You can change 
the fill mode to a gradient fill    by applying the Gradient Fill Tool to the shape.
You can also fill the shape with the current pattern with the Edit: Fill 
command. To change the color(s) used for the current fill, apply the    Object: 
Set Interior command.    
See Also: 

Shape Tools 



7.4 Text Objects

Text Objects allow you to place movable and editable text in your composite 
images. Unlike the "selection text" of    other retouch programs, our text 
objects keep around a high level description of thier contents, allowing you 
to easily correct for mistakes, change the font or change the alignment at 
any time. Another new feature is the ability to print text at printer resolution.
For those of you who like to combine 75-dpi bit maps with 300-dpi characters
this feature should definitely be checked out!

See Also:

Text Tool 



7.5 Selecting and Moving Objects

Selection of Objects is done with the Selection Tool (Arrow) on the Toolbox. 
When you click with this tool on any object that object becomes selected, 
and all other objects become deselected. If you want to add an object to the 
current selection use the Shift key while pressing down. If you want to toggle 
the selection state of one particular object, use the Control key while 
pressing down.

On the Menu, the Object: Select All, and Object: Select None commands are 
self-explanatory.

Moving objects around on the desktop is simply a matter of drag and drop. 
You can move an object anywhere within its window, or move it clear to 
another window (implicit cut and paste). If you hold the Shift key down while 
you are doing this operation you will copy the object instead of moving it. 



7.6 Grouping and Ungrouping

Once you have selected several objects you may want to group them 
together so that they can be moved as a single object. To do this, use the 
Object: Group command to unify all selected objects into one. At any time 
you can use the Object: Ungroup command to restore the objects back to 
their original state.

Note: you can group any types of objects e.g.: shapes with text. You can also 
have groups of groups, groups of groups of groups and so on.



 
7.7 Object Cut and Paste

Objects can be cut or copied to the clipboard with the Edit: Cut and Edit: 
Copy commands. You can then use the Edit: Paste command to paste the 
objects back into a window.

When you cut or copy an object in Matisse you are implicitly saving that 
object to the Matisse private clipboard. This allows you to paste that object 
back into Matisse at a later time. Matisse needs to use its own clipboard to 
fully save all the details of the object, such as the Marquee Information, 
Compositing rules etc...

In order to communicate with other applications, such as Microsoft Word, 
however,
it is necessary to use the Windows clipboard, not the private Matisse 
clipboard. To make this easy for you to do, Matisse normally puts a separate 
copy of whatever is being cut or copied into the Microsoft Windows clipboard.
This allows you to import images back and forth between applications 
without having to worry about which clipboard is active.

This default procedure has only one problem - it requires twice as much 
clipboard memory. If you are running low on memory, you can disable the 
double-copying in the Preferences menu. It can always be enabled at a later 
time



7.8 Changing the Object Ordering

In Matisse, as in all draw programs, objects are displayed one on top of 
another, like pieces of paper lying on a desk. And, like pieces of paper lying 
on a desk, objects can get buried below other objects and often need to be 
reorganized so that the objects you need right now appear on top. The 
Object: Order command contain the Move Up, Move Down, Send To Front and
Send To Back commands which affect this ordering.



7.9 Snap To Grid

An invisible grid overlays each window in Matisse. The size of that grid is set 
with the File: Preferences : Grid Size command. The grid can be toggled on 
and off using the Object: Snap To Grid command. When the grid is on, objects
will move on grid points, which is particularly useful for precision alignment.



7.10 Align

Matisse support two types of object alignment commands. The first type, the 
(regular) Object: Align commands are used for aligning a set of objects to 
their bounding rectangle. The second type, the Object: Align to Image 
commands, aligns the objects to the top, bottom, right, left or center of the 
image.



7.11 Merging Objects

A floating object can be "Merged" into the background image using the 
Object: Merge command. Once an object is merged it can't be moved or 
distorted.



 
7.12 Resizing and Distorting Objects

One of the great things about objects is that you can resize and distort them 
without losing image quality. The tools to do this are the distort tools, located
on the top left "shelf" of the toolbox. They apply to all types of objects: 
Image Objects, Shapes and Text. For more information see Distort Tools.



7.13 Object Compositing

Compositing is the process of overlaying shapes, images and text objects on 
top of each other. Matisse does this by having each object keep around a 
composite rule which tells the system how that object should be merged 
onto the ones below it. The following rules are supported:

Normal Compositing : The object is blended using an opacity parameter. The
higher the parameter, the more opaque.

Blackness Compositing: A variant on Normal compositing with an extra 
parameter: a so called "blackness" value. The blackness value determines 
how much the colors turn to black as they are blended.

Additive Compositing: Straight addition of RGB values. 

Lighter Compositing: The lighter pixels show through.

Darker Compositing: The darker pixels show through.

Emboss Compositing: The object becomes embossed on what's below it.



7.14 The Make Marquee Command (Version 1.2)

Fauve Matisse Version 1.2 contains a very powerful command on the object 
menu called "Make Marquee".    This command creates a marquee around 
one or more selected objects.    It can be used as follows:

To crop out an object using a bezier shape:    To do this, first select the closed 
spline tool and define a bezier shape around a region of interest.    Then, 
activate the reshape tool to supress the filling of the shape and allow you to 
fine tune the shape definition.    You can now apply the "Make Marquee" 
command to create a marquee, followed by the "Make Floating" command to
create an object.    This procedure allows you to quickly achieve precise, 
antialiased object crops.

To convert a text or shape object to an image object.    There are times when 
you may want to change a floating text object to a floating image object so 
that you may paint it, or apply a filter to it.    To do this, simply select the text 
object, Apply "Make Marquee", and then again, "Make Floating".    You now 
have a floating image copy of the text object and may delete the original 
text if you so desire.

To create precise fills and opacity fills of objects.    By using the shape and 
make marquee command as illustrated above it is a snap to quickly define 
precise marquee areas.    Since all filling and filter operations are clipped to 
those marquee areas, this allows you for example to apply an opacity fill to 
transparent to an object, therby creating a hole in it.



7.15 The Opacity Commands (Version 1.2)

Fauve Matisse Version 1.2 contains an "Opacity" submenu of the Object 
menu.    This submemnu alllows you to import or export the opacity layer of a
selected object, fill the opacity layer of that selected object (ie: affecting the 
transparency), and even invert the layer, allowing you to use the object as a 
stencil.
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8.1 Filters - An Overview

Filters are computer routines which act on images to achieve blurring, 
distortion and other effects. You will find all of the filters in Matisse in the 
Image Menu, grouped under subcategories ranging from "Tuning" to 
"Texturize". All these filters (with the exception of the Tone Adjustment filter) 
lead to a standard dialog box which allows you to preview the impact of the 
Filter on a small portion of the image. 



8.2 Tuning Filters

Brightness/Contrast: Similar to the Brightness/Contrast controls on a TV. 
Increasing brightness adds pure white to the image. Increasing contrast 
tightens the color range. 

CMYK: Adds/Subtracts a fixed amount of Cyan, Magenta, Yellow or Black to 
each pixel in the image.

Colorize: Colorizes an image using a 256-color palette.    If you don't have 
such a palette, you can use the Edit: Palette: Sample Image command to 
extract one from another image. Note: This command only works on color 
images. If you want to colorize a gray scale (8 bit image) first convert it to 
True Color, and then apply the command.

Equalize: Equalizes out the image to contain an even mix of light and dark 
areas. It is particularly useful for re-touching under or over-exposed 
photographs, particularly gray-scale ones.

Invert: Inverts the image, producing a negative.

HLS: Adds/subtracts hue, lightness, and or saturation. Pumping up the 
saturation on an image is often a good way of adding life to it. 

Posterize: The term "posterize" means to compress the range of    color 
values. For example, on a gray scale image, setting the posterize level to five
will result in each channel going from 256 shades to 5 shades. This results in 
images which are somewhat "blotchy".    

RGB: Adds/Subtracts a fixed amount of Red, Green or Blue to each pixel in 
the image.
Tint: Creates a 256-shade image which "leans" towards the foreground color.
Gives a very clean, "tinted" look to an image or area which you cannot get by
other tuning adjustments.

Tone: Overall tone adjustment facility. Allows you to increase the shadows, 
midtones or highlights of the image and see the effects on the image 
interactively. The controls in effect re-ramp each of the gamma curves for 
the three channels R, G and B.



8.3 Blur Filters

Blur: Applies a 3x3 convolution blur to the image. A blur amount parameter 
is used to increase/decrease the weight on the center pixel, mildly changing 
the degree of blur.

Fragment: Superimposes a specified number of copies at random offsets. 
The variance of these offsets can be specified in pixels. 

Motion Blur: Superimposes a specific number of copies at a given distance 
from each other and at a specified angle to create the impression of 
movement. Using 4 or more copies at a distance of 3 pixels yields good 
results.

Gaussian Blur: Applies a smooth normalized or "gaussian" blur filter to the 
image. More "soft" than other blur filters, but slower. Blur amount is specified
by a radius in pixels (1-5).

Uniform Blur: Applies a uniform blur filter to the image. Essentially the 
same as the standard blur filter, but with a variable radius of up to 5 pixels 
(10x10 convolution). Like the gaussian blur, can be slow, especially on large 
images.



8.4 Convolution Filters

The term "convolution" is an image-processing term for a class of filters 
which are defined by a matrix of numbers. For each pixel, the new RGB 
values are defined as a weighted sum of the adjacent pixels. The convolution
matrix allows you to enter these weights. The result is divided by a scale 
factor, and shifted by an offset.



8.5 Distort Filters

Cylinder: This filter maps the image to a cylinder, like a "special effects" 
mirror at an amusement park. You can specify an amount between -100 and 
+100. A positive amount will cause the image to "bulge" , a negative amount
will cause it to be "squeezed". You can also specify whether the cylinder is 
vertical or horizontal.

Fish Eye: Creates the impression the picture was taken through a fish-eye 
lens. The degree of "bulge" is controllable with an amount parameter. 
Specifying a negative amount will cause the image to be "pinched"

Ripple: Creates a "rippled" wave over the image, similar to looking through 
heavy plate glass on a rainy day. The ripple is controlled by a wavelength 
and an amplitude factor. The best way to see how these two parameters 
interact is by playing around with them!

Wave: Creates a horizontal or vertical wave on the image. The wavelength 
and the amplitude of the wave can be specified. Like the Ripple filter, this 
one takes some trial and error to get comfortable with.

Whirlpool: Passes the image through a whirlpool vortex, creating a "twirl" 
effect. A twist amount in degrees (between -360 and +360) controls the 
degree of twirl.



8.6 Edge Detect Filters

Filters that detect and act on the edges of the image.

Emboss: Creates an "embossed look" using directional gradiant information.
The emboss depth controls how "protruded" the embossing looks. The 
contrast parameter is useful for increasing the sharpness of    the embossing.
The emboss angle is entered in degrees. Finally, you can specify a 
background color for embossing: foreground, background or gray.

Find Edge: Standard filter which finds all edges of the image and displays 
them in white on a black background. By checking the invert box, you can 
specify black edges on a white background.

Sharpen: Accentuates the edges of an image to increase the perceived 
"sharpness". A single parameter, amount, is used to regulate the degree of 
edge enhancement.

Threshold: This filter classifies all pixels into two categories: those whose 
R,G,B values are above a certain threshold and those who are below. The 
R,G,B threshold values are entered with three sliders and can be constrained 
to be equal by clicking on the constrain checkbox. You specify one color for 
the "above" pixels and one for the "below" pixels.

Variable Edge: A highly versatile filter for the image professional. For each 
pixel an edge gradient is computed. Depending on whether the edge is 
greater or less than a specific threshold, the pixel is colored in the "above" 
color or the "below" color. Color choices include HiLite (which sharpens the 
pixel) , Unchanged (leaves the pixel as is) and Raw (the raw gradient 
number, as displayed by the standard Find Edge filter).



8.7 Mosaic Filters

Included under this heading are filters which produce a clustered "mosaic" 
effect.

Maximum: This filter replaces each pixel with the lightest (maximum) pixel 
in a neighborhood around it. The neighborhood radius is given in pixels. 
Using values greater than 1 can slow this filter considerably.

Median: This filter replaces each pixel with the median lightness pixel in a 
neighborhood around it. The neighborhood radius is given in pixels. Using 
values greater than 1 can slow this filter considerably. The effect of the 
median filter is to blur the image without destroying edges. It is perfect for 
removing noise from an image, or blurring flat parts of an image while 
keeping straight lines relatively crisp. While not really a "mosaic" filter, we 
included it here to be next to the minimum and maximum filters.

Minimum: This filter replaces each pixel with the darkest (minimum) pixel in
a neighborhood around it. The neighborhood radius is given in pixels. Using 
values greater than 1 can slow this filter considerably.

Mosaic: Creates the "police suspect" look by grouping pixels in tiles and 
coloring each tile with its average color. You can specify the width and height
of the tiles, and constrain these to be equal by click the square checkbox.

Shatter: Creates a "David Hockney" look by cutting the image up into tiles 
and moving the tiles randomly around. You specify the tile width and height, 
the average movement in pixels, and optionally an amount of random tinting
that is applied to each tile.



8.8 Noise Filters

Add Noise: Adds a specific amount of white noise to the image. The amount 
is specified between 1 and 255.

Diffuse: Moves each pixel by a random amount, creating a very nice "grainy 
breakdown" of the image. 

Remove Noise: Checks each pixel's color relative to the median color of the 
neighboring pixels. If the difference is greater than a threshold, the pixel 
color is replaced with the median color. The strength parameter controls the 
noise threshold.



8.9 Texturize Filter

Texturizes the image using the current texture. The texture amount can be 
set to a number between 1 and 200. The angle of the light source can be 
entered in degrees.

Use for: adding paper texture to images.



8.10 Color Separation

The Image:Separate commands break an image down by channel. You can 
specify whether you want to use RGB, HLS or CMYK channels in the 
separation.

To optimize CMYK separations, you can modify any of the following 
parameters:

Threshold:    Starting threshold in % below which there is no black being 
generated.
Black generation: max % of black that will be generated.
Under color removal: % of black that will be removed from each C,M,Y triplet.

After separating out an image, each channel is given its own window, and 
can be modified using any of the paint or image processing commands. The 
Image: Recombine command can then be used to re-create a composite of 
the different channels.



8.11 Image Crop, Flip, Resample and Rotate

These four commands are located on the Image menu and have one thing in 
common - they apply globally to all objects in a given window. For instance 
the Image: Flip command flips all objects in the window, unlike the Object: 
Flip command which flips only selected objects.

Image: Crop: Crops the image to the current marquee. To use, first define a 
crop area with the Rectangle Marquee tool.

Image: Flip: Flips the entire window (including all objects) either horizontally 
or vertically.

Image: Rotate 90 Rotates the entire window (including all objects) by 90 
degrees.

Image: Resample Resamples the entire window (including all objects) to a 
given new width and height. These can be entered in either in pixels, inches, 
or as percent of the original image. You can also constrain the aspect ratio to 
be fixed to the aspect ratio of the old image.



8.12 Auto Paint

This switch toggles on auto painting mode. With Auto Paint, when the brush 
tool is active the right mouse button causes Matisse to automatically fill the 
image using the last brush stroke. (Normally the right mouse button simply 
repeats the last stroke once). 





Chapter 9: Folders

9.1 Overview
9.2 Icon Drag and Drop
9.3 Nested Folders



9.1 Folders : An Overview

Folders are an intuitive, graphical way of organizing your image files. For 
instance, you could construct a folder called "Vacation" with all your vacation
photographs. When the folder is brought up, you would see one small slide, 
or "icon"    for each snapshot in the series. By clicking on that slide you would
be able to bring up the corresponding image in full size, ready for editing.

The way folders work is by keeping around a filename for each image in the 
folder. Since the folder only contains the filename, not the actual image, you 
can include the same image in two different folders. For instance, the same 
picture of    "little johnny" could be included in a folder called "Kids" and 
another one called "1993". It is very important to recognize this distinction 
between folders - which contain references to files and DOS directories which
contain the actual files.

The easiest way to get aquainted with folders is to open one of the sample 
folders included with Matisse and play around with it. You will quickly see 
how easy they are to work with.



9.2 Icon Drag and Drop

The easiest way to move images around in folders is to simply pick them up 
with the cursor and then drag them to their desired location. The Shift and 
Control keys can be used here and have the same meaning as in the 
Microsoft FileManager.

In selecting images: Shift is used to select a range of images. Control is used 
to toggle the selection status of individual images.

In moving images outside of the folder: Shift is used to make a copy of the 
images.

You can of course, use the Cut, Copy and Paste commands on folders just as 
you would anywhere else.

Note: To add an image, palette or folder into another folder first minimize it 
to create a slide. Then darg the slide into the desired folder.



9.3 Nested Folders

One of the most powerful aspects of folders is that you can nest them - i.e: a 
folder can contain other folders. This feature allows you to create hierarchies 
of images, one level leading to another. The Master.fld folder included with 
Matisse illustrates this point. This folder contains several other folders 
including Images.fld and Palettes.fld. By clicking on the "Images.fld" slide, 
you bring up another folder of choices, in this case sample images.

The thumbnail that is used to represent the folder itself is called the folder 
cover. This image is by default blank, and can be set using the Edit: Folder: 
Set Cover command. If you want to modify an existing cover use the Edit: 
Folder: Get Cover command to retrieve it for editing.




